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Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s
primary role is to respond to specific queries about product features and functionality.
The Technical Support group also creates content for our online Knowledge Base.
The Technical Support group works collaboratively with the other functional areas
within Symantec to answer your questions in a timely fashion. For example, the
Technical Support group works with Product Engineering and Symantec Security
Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

= Arange of support options that give you the flexibility to select the right amount
of service for any size organization

= Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

» Upgrade assurance that delivers software upgrades

= Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

= Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at
the following URL.:

www.symantec.com/business/support/
All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be at
the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

s Product release level

= Hardware information
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= Available memory, disk space, and NIC information
= Operating system
= Version and patch level
= Network topology
= Router, gateway, and IP address information
= Problem description:
= Error messages and log files
= Troubleshooting that was performed before contacting Symantec

= Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:
www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

= Questions regarding product licensing or serialization

= Product registration updates, such as address or name changes

= General product information (features, language availability, local dealers)
» Latest information about product updates and upgrades

» Information about upgrade assurance and support contracts

= Information about the Symantec Buying Programs

= Advice about Symantec's technical support options

= Nontechnical presales questions

= Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan customercare_apj@symantec.com
Europe, Middle-East, and Africa semea@symantec.com

North America and Latin America supportsolutions@symantec.com
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Introducing Ghost Solution
Suite 3.0

This chapter includes the following topics:

= About Ghost Solution Suite 3.0

s Components of Ghost Solution Suite 3.0

= System requirement for installing the Ghost Solution suite

= Things to know

About Ghost Solution Suite 3.0

Symantec Ghost™ Solution Suite 3.0 is the industry’s most widely-used deployment,
system management, and computer imaging software solution. Use Ghost’s proven
hardware-independent imaging capabilities to significantly accelerate day-to-day
imaging and deployment needs. This Windows migration software can also migrate
client systems to the latest operating system, all from a single management console.
Symantec's Ghost™ Solution Suite 3.0 will introduce the Deployment Solution 6.9
console and core capabilities to Symantec Ghost™ Solution Suite users while
maintaining its best capabilities such as Ghost Cast Server, DeployAnywhere,
Recovery Kit, and installation simplicity.

Note: Symantec Ghost™ Solution Suite is designed to capture the legacy Symantec
Ghost™ Solution Suite 2.x and Symantec™ Deployment Solution customers.




Introducing Ghost Solution Suite 3.0 | 10
Components of Ghost Solution Suite 3.0

Components of Ghost Solution Suite 3.0

You can install all the Ghost Solution Suite components on the same computer or
distribute them across multiple computers, depending on the environment. Following
are the components of Ghost Solution Suite 3.0:

= Ghost Solution Suite Console

= Ghost Solution Suite Server

= Ghost Solution Suite database

= Ghost Solution Suite share

= PXE server

» Installing Ghost Solution Suite agent

= Sysprep

System requirement for installing the Ghost Solution
suite

The following list includes the minimum system requirements for installing Ghost
Solution Suite:

System requirements for installing Ghost Solution Suite

= Ghost Solution Suite (GSS) Agent
GSS Agents require network connectivity and around 5 MB disk space. Other
system requirements are the same as the host operating system.

= Ghost Solution Suite Server
We recommend running the GSS Server components on a modern, dedicated
server with a 1 GHz or faster processor with 1 GB or more RAM. At an absolute
minimum, this server should have a PIllI-compatible 600 MHz or newer processor
with 512 MB RAM.

= Computers hosting additional PXE servers and file shares should meet the
requirements of the operating system hosting these components.

= Automation Requirements
Microsoft recommends 512 MB of memory for computers booting WinPE. At a
minimum, you should have 384 MB to avoid boot errors.

» [fthe SQL Server Express database is installed from within the GSS 3.0 installer,
then .NET framework 3.5 or above is also a pre-requisite.
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Things to know

s For WinPE 5.1, .NET 4.5 Framework should be installed before importing the
Windows ADK 8.1.

Things to know

The following table lists the important things that you must know when you upgrade
to GSS 3.0 from previous versions of Ghost Solution Suite or Deployment Solution:

Table 1-1 Ghost Solution Suite 3.0

Item Particulars

Default logon credentials after Scripted OS | After running the Scripted OS Install task on
Install task a computer, the default logon credentials are
set as follows:

User name: Symantec
Password: Symantec

Earlier the default logon credentials were set
to as follows:

User name: Altiris

Password: Altiris

Cannot connect to the DAgent. After booting into the Windows preboot
environment, an error stating unable to
connect to DAgent is displayed.

Workaround:

Edit the aclient.inp and add the following
parameter value in the file:

Transportuse=1

Scripted OS Install task for Windows XP For the detailed steps on running the
Scripted OS Install task, refer to the
following connect article:

http://www.symantec.com/connect/articles/

Change of IP address of Ghost Solution Suite | Change in IP address of Ghost Solution Suite
Server affects PXE functionality and database | Server affects PXE functionality and database
services. services.

For more information on how to change a
Ghost Solution Suite server’s IP address,
refer to the following article:

HOWTO80637



http://www.symantec.com/connect/articles/deployment-server-69-quick-start-course-part-14-scripting-xp-sp3
https://support.symantec.com/en_US/article.HOWTO80637.html
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Things to know

Table 1-1 Ghost Solution Suite 3.0 (continued)
Item Particulars
Prerequisites for DAgnet installation The prerequisites for installing DAgent are as
follows:

s Firewall and antivirus must be turned off.
If you must have them ON, ensure that
they are configured with the required port
as open to install the DSAgent.

s UAC must be turned off on the computers
that are installed with Windows Vista and
above versions.

You can turn on the UAC after installing
the DAgent.




Installing Ghost Solution
Suite Server

This chapter includes the following topics:

Installing Ghost Solution Suite Server

Platform Support

System requirements for installing Ghost Solution Suite
Installing the Ghost Standard tools from the installer
Browsing to the Ghost Recovery kit

Ghost Solution Suite Server components

Ghost Solution Suite Console

Ghost Solution Suite Server

Ghost Solution Suite Database

Support for multiple database instances

Ghost Solution Suite Share

PXE server

Simple install for Ghost Solution Suite Server
Custom install for Ghost Solution Suite Server

Thin client install

Component install



Installing Ghost Solution Suite Server

Installing Ghost Solution Suite Agents

Client connectivity and network adapters
Installing the Ghost Solution Suite agent
Remote agent installer

Enter administrator account information
Specify install directory

Automatically add to a group

Select computers on the network

Download Microsoft sysprep

Change settings

Get server security key

Installing Ghost Solution Suite agent for Windows
Automating the installation of Ghost Solution Suite agent
Editing the sample.inp file

Using remote agent installer

Using the template file

Installing Ghost Solution Suite agent on Linux
Installing the automation agent

Installation help

Configuration

Installing Ghost Solution Suite Server

Ghost Solution Suite Server install

Pre-boot operating system (simple)

Pre-boot operating system (custom)

Ghost Solution Suite Database install

PXE server install

Client connection to server

14
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Installing Ghost Solution Suite Server

= Sysprep

= Installing components

= Installation information summary

= Add components summary

= Ghost Solution Suite Database authentication

= Add components

Installing Ghost Solution Suite Server

Ghost Solution Suite Server is a flexible, scalable computer deployment and
management system that can be installed and configured on a single computer, or
installed across several computers to distribute processing for large enterprise
environments. You can run a Simple install to position all Ghost Solution Suite
Server Components on a single computer (most frequently used), or plan and
perform a Custom install to distribute installation of components across separate
computers in the site.

See “Ghost Solution Suite Server components” on page 22.

After installing Ghost Solution Suite Server components, you can remotely install
Ghost Solution Suite Agents on all types of computer resources across your
organization: laptops, LAN and Web servers, network switches, and so on. Windows
computers and Linux computers can be managed as a unified environment, with
each client communicating through its own Ghost Solution Suite agent to update
inventory data and react to Ghost Solution Suite Server commands and deployment
tasks.

Select one of the following methods for installing a Ghost Solution Suite Server
system:

= Simple install for Ghost Solution Suite Server
Install all components on local computer

= Custom install for Ghost Solution Suite Server
Installs components on remote or local computers and lets you customize
options.

= Thin client install
Installs GSS Thin client view.

= Component install
Installs additional Ghost Solution components.

»  Ghost Recovery Kit
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Platform Support

Lets you browse to the Ghost Recovery Kit.

= Ghost Standard Tools
Launches the symantec Ghost Standard Tools installer thatlets you install
the Symantec Ghost Standard Tools.

To install Ghost Solution Suite Agents on the client computer, refer to the following
section:

See “Installing Ghost Solution Suite Agents” on page 40.

Registering Ghost Solution Suite

You can view the status of the licenses of Ghost Solution Suite and add the license
file from the Symantec Ghost Solution Suite Registration menu which is present
under the Help > Register.

Table 2-1 Symantec Ghost Solution Suite Registration
Field Description
License Summary Displays the number of Server Nodes and Customer
Nodes
License Information Displays Ghost Solution Suite and the current

installed version.

Displays the total count of the licenses.

License File Browse to the location of the SLF license file.

Platform Support

This section lists the supported platforms for Ghost Solution Suite 3.0:

Table 2-2 Platform support matrix for Ghost Solution Suite 3.0
Platform Client Server File Server | Database
Windows Server 2012 Yes Yes Yes Yes
Windows Server 2012 R2 Yes Yes Yes Yes
Windows 8 Yes
Windows 8.1 Yes

16



Installing Ghost Solution Suite Server
Platform Support

Table 2-2 Platform support matrix for Ghost Solution Suite 3.0 (continued)
Platform Client Server File Server | Database
Windows 7, including Embedded Standard, | Yes
Professional, Enterprise, and Ultimate
editions
Windows 2008 Core Yes
Windows Server 2008 (x86 and x86_64), Yes Yes Yes Yes
including R2 and SP2
Windows XP SP3 Yes
VMWare ESX Server 4.0 (vSphere) Yes

Support is provided
for VMware ESX
Server scripted
installations.

VMWare ESX Server 3.5

Yes

Support is provided
for VMware ESX
Server scripted
installations.

VMWare ESX Server 3.0

Yes

Support is provided
for VMware ESX
Server scripted

installations.
Mac OS X 10.6 Yes
Mac OS X 10.7 Yes
Mac OS X 10.8 Yes
Mac OS X 10.9 Yes
Mac OS X 10.10 Yes
Red Hat Enterprise Linux 5 Yes
Red Hat Enterprise Linux 5 x86_64 Yes
Red Hat Enterprise Linux 5 Yes

17
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Table 2-2 Platform support matrix for Ghost Solution Suite 3.0 (continued)
Platform Client Server File Server | Database
Red Hat Enterprise Linux 4 Yes
Red Hat Enterprise Linux 4 x86_64 Yes
Red Hat Enterprise Linux 4 Yes
Red Hat Enterprise Linux 6.5 Yes
SuSE Linux Enterprise Server 11 Yes

SuSE Linux Enterprise Server 11 x86_64 Yes

SuSE Linux Enterprise Server 11 Yes

SuSE Linux Enterprise Server 10 Yes

SuSE Linux Enterprise Server 10 x86_64 Yes

SuSE Linux Enterprise Server 10 Yes

SuSE Linux Enterprise Server 9 Yes

SuSE Linux Enterprise Server 9 x86_64 Yes

SuSE Linux Enterprise Server 9 Yes

Debian Linux 5 (and prior) Stable Yes

Solaris SPARC 8, 9 (production agent only) | Yes

NetWare 6.5 Yes

System requirements for installing Ghost Solution
Suite

The following list includes the minimum system requirements for installing Ghost
Solution Suite:

System requirements for installing Ghost Solution Suite:

= Ghost Solution Suite (GSS) Agent
GSS Agents require network connectivity and around 9 MB disk space. Other
system requirements are the same as the host operating system.

s Ghost Solution Suite Server

18
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System requirements for installing Ghost Solution Suite

Symantec recommends running the GSS Server components on a modern,
dedicated server with Pentium 4 processor and 2GB of RAM.

Computers hosting additional PXE servers and file shares should meet the
requirements of the operating system hosting these components.

Automation Requirements

Microsoft recommends 512 MB of memory for computers booting WinPE. At a
minimum, you should have 384 MB to avoid boot errors.

If the SQL Server 2014 Express database is installed from within the GSS 3.0
installer, then .NET framework 3.5 must be installed.

For more information on system requirements for installing SQL Server 2014
Express, see the following URL:
https://msdn.microsoft.com/en-us/library/ms143506.aspx

Note: If you face an error while installing SQL Server Express, Symantec
recommends checking if all the Windows updates are installed.

For WIinPE 5.1, .NET 4.5 Framework should be installed before importing the
Windows ADK 8.1.

Ports and Protocols used in Ghost Solution Suite 3.0
The following table lists the ports that are used in Ghost Solution Suite 3.0:

Table 2-3 Ports used in Ghost Solution Suite
Component Service Port(s) Protocol Where is this Is this port
port connected? | configurable?

PXE MTFTP MTFTP 69 UDP PXE Client No

1758 UDP (Multicast) | PXE Client Yes [Configure by

1759 fe”d(-;]tlng PXE.ini
PXE Server PXE Server 67 UDP PXE Client No

68 UDP PXE Client No

4011 UDP PXE Client No

19
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Installing the Ghost Standard tools from the installer

Table 2-3 Ports used in Ghost Solution Suite (continued)
Component Service Port(s) Protocol Where is this Is this port
port connected? | configurable?
PXE Manager PXE Manager 405 TCP PXEConfig Yes [Configure by
editing RPC.ini
file]

406 TCP PXECfg Service | Yes [Configure by
editing RPC.ini
file]

PXECfg Service | PXECfg Service |407 TCP PXE Server and | Yes [Configure by
PXE MTFTP editing RPC.ini
file]
DB Management | DB Management | 505 TCP Win32 console, |Yes
(mm) Service axengine,
pxemanager
Ghost Solution Axengine 402 TCP/UDP Agents, Yes
Suite Server (multicast) pxeserver,
DataManager,
PXEManager
Linux Agent ADLagent 415
AClient AClient 402
PCT Real-time 4949
Destination
Agents 3829

4950

4951

4952

Installing the Ghost Standard tools from the installer

Ghost Solution Suite lets you install the Ghost Standard tools from the link that is
provided in the installer. The Ghost Standard tools include the following:

= Boot Disk Creator.exe
s Ghost Explorer x64.exe

s Ghost Explorer x86.exe

20
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Installing the Ghost Standard tools from the installer

s GhostCast Server.exe
s Ghost32.exe
s Ghost64.exe

The Ghost Standard tools are installed at the following location and are accessible
from the Start menu:

<Install dir/>/Program Files (x86)/Symantec/Ghost
To install Ghost Standard tools

1 Start the server and log on using the administrator account you created for the
Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite installation file and
follow the setup steps.

The Symantec Packager Self-Extracting Executable Options dialog appears.

Select the Use current temp folder option to use the current temporary folder
to download installation files or the Extract to a specific folder option to set
a path to an existing folder to download the installation files.

5 Click Extract and Execute App to extract and execute the application
immediately.

The default installation directory is C:\DSSetup. If the file C:\DSSetup\AppLic.dll
already exists, a prompt appears, asking whether you want to overwrite this
file. Click Yes to All. You may have to wait for some time while Symantec
Packager extracts files from this archive.

Note: Click Extract Only to only extract the application and execute the
application later. You must run the axinstall.exe file to start the installation.

6 In the Ghost Solution Suite Server Install Configuration dialog, click on
Ghost Standard Tools.

7 Inthe Symantec Ghost Standard Tools wizard, the default path where the
Ghost Standard Tools executables are installed is displayed as follows:

C:\Program Files (x86) \Symantec\Ghost

To change the path where the Ghost Standard Tools executables are installed,
click on Change....

Click Next >.
Click Install.

21
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Browsing to the Ghost Recovery kit

Browsing to the Ghost Recovery kit

The Ghost Solution Suite lets you browse to the Ghost Recovery Tool kit at the
following location:

<Install_Dir>:\DSSetup\Ghost_recovery_Kit.zip

Symantec Ghost Recovery Kit is a suite of tools designed for original equipment
manufacturers (OEMs) and value-added resellers (VARSs). It adds tools and
functionality to the applications included in Symantec Ghost Solution Suite. Symantec
Ghost Recovery Kit includes the following tools:

GhostOEM32
GhostOEMB32 is a Win32 version of GhostOEM and is designed to run on
Microsoft Windows Preinstallation Environment (WinPE).

GhostOEM64
GhostOEM32 is a Win64 version of GhostOEM and is designed to run on
Microsoft Windows Preinstallation Environment (WinPE).

PQIDeploy

PQIDeploy is an OEM version of Symantec ImageCenter that provides
restore-only capabilities. It contains the full scripting capabilities that are included
in ImageCenter. It does not include any graphical user interface (GUI). All
commands are specified in a script command file.

PQIDplyD

SRFixMbr

The System Recovery Fix MBR executable installs the Boot Partition Selector
in the Master Boot Record (MBR).

The Boot Partition Selector requests which partition the end user wants to launch
when the computer is booted from the primary hard drive. If no response is
made within the timeout interval, then the user partition is launched. Alternatively,
the end user can launch the recovery partition. The end user can access the
recovery partition only through the Boot Partition Selector.

Ghost Solution Suite Server components

The Ghost Solution Suite Server system includes the following components:

Ghost Solution Suite Console
See “Ghost Solution Suite Console” on page 23.

Ghost Solution Suite Server
See “Ghost Solution Suite Server” on page 23.

Ghost Solution Suite Database



Installing Ghost Solution Suite Server | 23
Ghost Solution Suite Console

See “Ghost Solution Suite Database” on page 25.

= Ghost Solution Suite Share
See “Ghost Solution Suite Share ” on page 26.

= PXE server
See “PXE server” on page 27.

= DHCP Server (not an Symantec product)
» Installing Ghost Solution Suite agents
= Sysprep

You can install all these components on the same computer or distribute them
across multiple computers, depending on the environment.

Ghost Solution Suite Console

The Ghost Solution Suite Console is the Win32 user interface for Ghost Solution
Suite . You can install this Windows console on computers across the network to
view and manage resources from different locations. In addition, from this console,
you can access the Ghost Solution Suite Database on other Ghost Solution Suite
Server systems to manage sites across the enterprise.

See “Ghost Solution Suite Database” on page 25.

The Ghost Solution Suite Console communicates with the Ghost Solution Suite
Database and Deployment services. In a Simple Install for Ghost Solution Suite
Server, the Ghost Solution Suite Console is installed on the same computer similar
to all other components. In a Custom Install for Ghost Solution Suite Server, you
must ensure that a connection is available to these computers and security rights
are set. You must have administrative rights on any computer running the Ghost
Solution Suite Console.

See “Simple install for Ghost Solution Suite Server” on page 28.

See “Custom install for Ghost Solution Suite Server” on page 31.

Ghost Solution Suite Server

Ghost Solution Suite Server controls the flow of the work and information between
the managed computers and the other Ghost Solution Suite Server components
(Ghost Solution Suite Console, Ghost Solution Suite Database, and the Ghost
Solution Suite Share ). Managed computers connect and communicate with the
Ghost Solution Suite Server to register inventory and configuration information and
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Ghost Solution Suite Server

to run deployment and management tasks. The computer and deployment data for
each managed computer is stored in the Ghost Solution Suite Database.

Note: To view, start, or stop Ghost Solution Suite Server, go to the Symantec Server
services in your Windows Manager.

Managed computers require access to the Ghost Solution Suite Server at all times,
requiring that you have administrative rights on the computer running the Ghost
Solution Suite Server.

Create a user account to run the Ghost
::::; | Solution Suite Server. The service runs as a
logged-on user, not as a system account. You
must create this account on all Ghost Solution
Suite Server computers. The account must
have full rights to the Ghost Solution Suite
Share . The account must have a
non-expiring password.

See “Ghost Solution Suite Share ”
on page 26.

Assign a static IP address to the Ghost
E :l Solution Suite Server computer. Other
= components cannot connect to the Ghost

Solution Suite Server if you use DHCP and
dynamically change the IP address.

To install the Ghost Solution Suite Server on
a remote computer, the default administration
L shares must be present. Restore any shares
that have been removed before you install
the Ghost Solution Suite Server.

Note: It is easier to create an administrative account using the same name and
password on all computers than to use the existing name and password of each
account.

Most packages (.RIP, Personality Packages, and .MSl files) pass through the Ghost
Solution Suite Server. Therefore, if you store these files on the Ghost Solution Suite
Server, the deployment of these packages is faster. Image files, however, are sent
directly from the Ghost Solution Suite Share to the client computer when you run
an imaging task.

See “Ghost Solution Suite Server components” on page 22.

24
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Ghost Solution Suite Database

Ghost Solution Suite Database

You can install the Ghost Solution Suite Database on Microsoft SQL Server™ 2014
Express edition.

Note: In Ghost Solution Suite 3.0 and later, if you have already set up multiple
instances of the Microsoft SQL Server, you can identify a specific instance using
this format: <database instance>\express. Example: If you have a clustered
Microsoft SQL Server named soLnclustersvr to manage multiple Ghost Solution
Suite systems on different network segments, you can enter the name
SQLClusterSvr\salesSegment OF SQLClusterSvr\marketingSegment during the
Ghost Solution Suite Server setup, depending on the previously established
database instance. This feature is supported in the silent install . 1n1 file and the
GUI install executable.

The database maintains the following information about the managed computers:
= Hardware. RAM, asset tag, and serial numbers

= General Information. Computer name and MAC address

= Configuration. TCP/IP, Microsoft networking, and user information

= Applications. The installed applications and information about these applications,
such as the name of the application, publisher, and product ID

s Services. Installed Windows services

= Devices. Installed Windows devices, such as network adapter, keyboard, and
monitors

» Location information. Contact name, phone, e-mail, department, mail stop, and
site

The Ghost Solution Suite Server Database also contains jobs and other data used
to manage your computers.

Note: You can install a single Ghost Solution Suite Database in each Ghost Solution
Suite Server system-you cannot have two databases storing data for a single
computer. If the computer you are installing the database on has an existing
Microsoft SQL Server™, the Ghost Solution Suite Database is added to that instance
of the database engine.
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Support for multiple database instances

Support for multiple database instances

In Ghost Solution Suite 3.0, you can identify a named instance of the Microsoft SQL
Server when installing Ghost Solution Suite . You can now identify other named
instances of Microsoft SQL Servers instead of accessing only the default instance.
This feature lets you identify and run multiple databases from one clustered Microsoft
SQL Server to manage multiple sites or network segments. This feature is supported
in the silent install .INI file and the GUI install executable. Ghost Solution Suite also
supports a different name for the Ghost Solution Suite Database instead of the
default name, eXpress.

See “Custom install for Ghost Solution Suite Server” on page 31.

See “Ghost Solution Suite Server components” on page 22.

Ghost Solution Suite Share

The Ghost Solution Suite Share is a file server or shared directory where Ghost
Solutin Suite program files and packages are stored. The Ghost Solution Suite
Share can be a shared directory (default Simple install in Program Files\
Altiris\eXpress\Deployment Server)or another file server (in the Custom install,
you can assign a Microsoft Windows or Novell NetWare file server).

Ghost Solution Suite Share is where you store image files, registry files, .MSI
packages, Personality Packages, script files, and more. When you are deploying
or managing a computer, the Ghost Solution Suite Server stores and retrieves these
packages from the Ghost Solution Suite Share as needed.

If you want to install Ghost Solution Suite on
"'I':: ; | a remote file server (not the computer where

you are running the install program), create
a share (or give Read/Write rights for
NetWare) on the file server where you want
to install the Ghost Solution Suite Server. This
share must allow access to all other
components, including managed computers
and the user account that runs the Ghost
Solution Suite Server.

You must create this share before you begin
installing. If you are not installing on a remote
computer, you can select the option to create
the share during the installation.
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Note: You can install only one Ghost Solution Suite Share for each Ghost Solution
Suite Server system. However, if the Ghost Solution Suite Share 's hard drive gets
full, other computers can be used as additional backup storage points. In some
cases, other systems emulating a Microsoft or NetWare environment can be used
as the Ghost Solution Suite Share .

Note for NetWare users: If you have a problem using the Novell NetWare server
as a Ghost Solution Suite Share , install the Novell Client instead of the Microsoft
NetWare Client.

See “Ghost Solution Suite Server components” on page 22.

PXE server

The PXE Server provides service to client computers on a subnet. When the Ghost
Solution Suite Server sends a deployment job, the client computer receives a request
to boot to automation and the PXE-enabled computers connect to the first PXE
Server that they discover, which communicates with the Ghost Solution Suite Server
and the client computers.

You can install a PXE Server on a Microsoft Server 2003, Windows 2000 Server,
Advanced Server. The PXE Server also functions on the same protocols as a
standard DHCP Server, so you can place the PXE Server wherever you would
place a DHCP server. You can also install as many PXE Servers as required in
your system, but you must also install a DHCP Server.

The PXE Server sends a boot menu option list to the client when the computer
performs a PXE boot. The deployment job, which contains at least one automation
task, uses the default automation environment or the environment specified by a
user who has the permission to create a deployment job. Use the boot menu option
to request the PXE Server for the boot menu files and download the boot menu
files from the PXE Server to the client computer's RAM storage. The client computer
always boots according to the request and reply communications taking place
between the Deployment and PXE Servers.

Ghost Solution Suite supports Linux, and Windows Prelnstallation Environment
(WinPE) as pre-boot environments. These options let you create a single job, but
may contain multiple automation tasks. The default automation environment (the
first pre-boot operating system files installed during the Ghost Solution Suite
installation) is used for Initial Deployment, unless you specify otherwise.

Using a PXE Server to boot client computers to automation saves you from having
to install an automation partition on each client computer's hard disk, or from
manually starting computers using Symantec Ghost Solution Suite supported
bootable media.
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See Boot Disk Creator Helpand see PXE Configuration Utility Help.

See “Pre-boot operating system (simple)” on page 52.

DHCP Server

The DHCP (Dynamic Host Configuration Protocol) server is a server set up to assign
TCP/IP addresses to the client computers. This server is not an Symantec product,
but is required if you want to use the PXE Server.

We recommend that you use DHCP to manage the TCP/IP address in your network,
whether you use PXE or not. This greatly reduces the amount of time required to
set up and manage your computers.

See “Ghost Solution Suite Server components” on page 22.

Simple install for Ghost Solution Suite Server

The Simple Install option places all the Ghost Solution Suite Server Components
- Ghost Solution Suite Server, Ghost Solution Suite Console, Ghost Solution Suite
Share , and Ghost Solution Suite Database - on the same computer.

See “Ghost Solution Suite Server components” on page 22.

You can install the Ghost Solution Suite Server with a Microsoft Desktop Engine
(MSDE) by using the Simple Install.

SymantecGhostSolutionSolutionWin (version)
:;::; | installs all Windows components of Ghost

Solution Suite. Using the Simple Install option,
you can install MSDE 2000 on a local
computer if a database is not already
installed.

Note: Simple installation works only with a default Microsoft SQL 2000, SQL 2005,
SQL 2014, or MSDE install.

To run a simple install

1 Start the server and log on using the administrator account you created for the
Ghost Solution Suite Server.

See “PXE server” on page 27.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file
and follow the setup steps.

The Symantec Packager Self-Extracting Executable Options dialog appears.
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Select the Use current temp folder option to use the current temporary folder
to download installation files or the Extract to a specific folder option to set
a path to an existing folder to download the installation files.

Click Extract and Execute App to extract and execute the application
immediately.

The default installation directory is c: \Dssetup. If the file
C:\DsSetup\AppLic.dll already exists, a prompt appears, asking whether
you want to overwrite this file. Click Yes to All. You may have to wait for some
time while Symantec Packager extracts files from this archive.

Note: Click Extract Only to only extract the application and execute the
application later. You must run the axInstall.exe file to start the installation.

Select the Simple Install option from the installation types listed in the Ghost
Solution Suite Server Install Configuration dialog.

(Optional) Select the Include PXE Server option to install the PXE Server and
click Install.

See “PXE server” on page 27.
Click Yes on the Software License Agreement page.

Enter the following information on the Ghost Solution Suite Share Information

page:

= Inthe File Server path field, enter or browse to the path to install the Ghost
Solution Suite Server program files. The default path is c:\Program
Files\Altiris\eXpress\Deployment Server.

= Select the Create Ghost Solution Suite Share option to create a Ghost
Solution Suite Share on the computer. The Ghost Solution Suite Share lets
you store files on the computer and run Ghost Solution Suite Server system
applications.
See “Ghost Solution Suite Share ” on page 26.

= Browse and select the licence file.

= You must enter an administrator user name and password for the Ghost
Solution Suite Server. This account must already exist on the Ghost Solution
Suite Share and the Ghost Solution Suite Server. By default, the name you
are currently logged on as appears. If you use a domain account, enter the
domain and the user name (Example: Domain1\administrator).
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Note: If a previous installation of the Ghost Solution Suite Database is
detected, an axinstall prompt appears, asking whether you want to
preserve or overwrite the existing database. Click Yes to preserve the data
in your Ghost Solution Suite Database.

Click Next. The Pre-boot Operating System page appears.

Select a default pre-boot operating system from any one of the options, such
as Linux, WIinPE, or None. Browse to locate the FIRM file Linux operating
systems or the operating system files and WinPE. Click Next. The Installation
Information page appears, displaying the components that you selected to
install.

Click Install to install the listed components, or click Back to modify the settings
before starting the installation. The installation process begins and can take
several minutes. The Installation Information Summary page appears after
the installation completes.

Note: If you are upgrading your installation, the message Do you want to
replace the share? appears. Click Yes and continue. If you click No, a
message appears, stating that the share is already in use and you need to
manually set the share to point to the correct directory. Click OK.

(Optional) You can select the following option to install agents.

= Remotely install Ghost Solution Suite agent (Windows Vista, 2008 or
later only). Select this option if you want to push the Ghost Solution Suite
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agent to computers running Windows Vista, Windows 2008, or later
operating systems.

13 Click Finish.

You have successfully completed a Simple Install for a Ghost Solution Suite
Server system. Click the Ghost Solution Suite Console icon on your desktop
to view all the computer resources running Ghost Solution Suite Agents
configured for your Ghost Solution Suite Server.

Note: Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the
"Unable to connect to the Symantec Ghost Solution Suite Server Management
Server. Please ensure this service is started and running currently." error
appears. This occurs because the service files are deleted by the antivirus
application during scanning. To resolve this issue, disable the antivirus software
and reinstall the Ghost Solution Suite Server.

See “Custom install for Ghost Solution Suite Server” on page 31.

Custom install for Ghost Solution Suite Server

The Custom Install option lets you distribute all the Ghost Solution Suite Server
Components - Ghost Solution Suite Server, Ghost Solution Suite Console, Ghost
Solution Suite Share , and Ghost Solution Suite Database - on different computers.
You can install Ghost Solution Suite Server with a Microsoft Data Engine (MSDE)
or install it on an existing SQL Server.

See “Ghost Solution Suite Server components” on page 22.

SymantecGhostSolutionSuiteWin (version)

"'I'::; | installs all Windows components of Ghost

Solution Suite. Select the Custom install

option to add new components or to install
Ghost Solution Suite on an existing database.

To run a custom install

1

Start the server and log on as the administrator account you created for the
Ghost Solution Suite Server.

Launch the appropriate Symantec Ghost Solution Suite Server installation file
and follow the setup steps.

The Symantec Packager Self-Extracting Executable Options dialog appears.
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Click the Use current temp folder option to use the current temporary folder
to download installation files or the Extract to a specific folder option to set
a path to an existing folder to download the installation files.

Click Extract and Execute App to extract and execute the application
immediately.

The default installation directory is c: \Dssetup. If the file
C:\DsSetup\AppLic.dll already exists, a prompt appears, asking whether
you want to overwrite this file. Click Yes to All. You may have to wait for some
time while Symantec Packager extracts files from this archive.

Note: (Optional) Click Extract Only to only extract the application and execute
the application later. You must run the axInstall.exe file to start the installation.

Select the Custom Install option from the installation types listed in the Ghost
Solution Suite Server Install Configuration dialog if any of the following
conditions exist:

= You are using the NetWare file server as a Ghost Solution Suite Share .

= You are managing many computers and require a distributed architecture
to meet bandwidth restrictions and other design requirements.

Click Install. Click Yes on the Software License Agreement page.

Enter the following information on the Ghost Solution Suite Share Information

page:

= Inthe File Server path field, enter or browse to the path to install the Ghost
Solution Suite Server program files. The default path is c: \Program

Files\Altiris\eXpress\Ghost Solution Suite Server.

s Select the Create Ghost Solution Suite Share option to create a Ghost
Solution Suite Share on the computer. The Ghost Solution Suite Share lets
you store files on the computer and run Ghost Solution Suite Server system
applications. The Ghost Solution Suite Share can exist on a Microsoft
Windows server or Novell NetWare server.

Note: You can only create the share if it is on a Microsoft Windows Server;
the Novell share should already be set up. See “Ghost Solution Suite Share
” on page 26.

= Browse and select the (.SLF) licence file.
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Enter the following information on the Ghost Solution Suite Server
Information page:

Select the computer where you want to install the Ghost Solution Suite
Server. You can install the Ghost Solution Suite Server on the local computer
or on a remote computer. The IP address and the port information for the
selected computer are displayed by default.

Enter the path where you want to install the Ghost Solution Suite Server.

You must enter an administrator user name and password for the Ghost
Solution Suite Server. This account must already exist on the Ghost Solution
Suite Share and the Ghost Solution Suite Server. By default, the name you
are currently logged on as appears. If you use a domain account, enter the
domain and the user name (Example: Domain1\administrator).

(See “Installing Ghost Solution Suite Server” on page 15.) Click Next.

Enter the Ghost Solution Suite Database information and click Next.

Specify the Microsoft SQL Server Instance where you want to install the
database. See Ghost Solution Suite Database

Note: If you have already set up multiple instances of the Microsoft SQL
Server, you can identify a specific database instance in this field using the
format: <sQL Server Name>\<database instance>.

Depending upon the selection of the SQL Server instance, the default port
at which the selected instance is listening appears in the SQL Port Number
field. You can edit the port number if you have manually entered the SQL
Server name or if the port number does not appear automatically due to
some firewall restriction.

You can enter a name other than eXpress in the Database Name field.
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10 Select the type of Ghost Solution Suite Database authentication to be used.

11

12

13

You must enter the user name and password if you want to use SQL Server
authentication.

Note: You cannot use the remote SQL database with NT authentication on a
remote computer if you do not have administrative rights on the computer.

Click Next. The Pre-boot Operating Systems page appears.

Note: If a previous installation of the Ghost Solution Suite Database is detected,
an axinstall prompt appears, asking whether you want to preserve or
overwrite the existing database. Click Yes to preserve the data in your Ghost
Solution Suite Database.

Select a default pre-boot operating system from any one of the options, such
as Linux, or WinPE. Browse to locate the FIRM file (for Linux operating systems)
or enter the path for the operating system files (for WinPE). Click Next.

Note: If you are using a free evaluation license, you cannot use the WinPE
Add-On Packages.

Enter the PXE Server information. (See “PXE server” on page 27.) Select the
pre-boot operating system to use as the default PXE boot menu item. You can
select, Linux, or WIinPE. If you want to use the previously installed pre-boot
operating system, select the Keep current default option. Click Next.

Specify how you want to connect your managed computer to the Ghost Solution
Suite Server by selecting one of the following options.

= Select the Connect directly to Ghost Solution Suite Server option and
enter the Ghost Solution Suite Server IP address and port.

= Select the Discover Ghost Solution Suite Server using TCP/IP multicast
option and provide the Server name.

Note: If you leave the Server name field blank, the Ghost Solution Suite agent
connects to the first Ghost Solution Suite Server that responds. Click Next.
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14 Click Install to install the listed components or click Back to modify the settings
before starting the installation. The installation process begins and can take
several minutes. The Installation Information Summary page appears after
the installation completes.

Note: If you are upgrading your installation, the message Do you want to
replace the share? appears. Click Yes and continue. If you click No, a
message appears stating that the share is already in use and you must manually
set the share to point to the correct directory. Click OK.

15 (Optional) You can the following option to install agents on the managed
computers.

= Remotely Install Ghost Solution Suite agent (Windows Vista, 2008 or
later only). Select this option if you want to push the Ghost Solution Suite
agent to Windows computers directly after the installation. This can be done
any time by selecting Tools > Remote Agent Installer.

16 Click Finish.

You have successfully completed a Custom Install for a Ghost Solution Suite Server
system. Click the Ghost Solution Suite Console icon on your desktop to view all
the computer resources running Ghost Solution Suite Agents configured for your
Ghost Solution Suite Server.

See “Simple install for Ghost Solution Suite Server” on page 28.

Thin client install

The thin client install option lets you install the Thin Client view of the Ghost Solution
Suite Console on your computer. You can install Ghost Solution Suite Server with
a Microsoft Data Engine (MSDE) or install it on an existing SQL Server. You need
not provide a license file for the Thin Client installation.

To run a thin client install

1 Start the server and log on using the administrator account you created for the
Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file
and follow the setup steps.

The Symantec Packager Self-Extracting Executable Options dialog appears.
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Select the Use current temp folder option to use the current temporary folder
to download installation files or the Extract to a specific folder option to set
a path to an existing folder to download the installation files.

Click Extract and Execute App to extract and execute the application
immediately.

The default installation directory is c: \Dssetup. If the file
C:\DsSetup\AppLic.dll already exists, a prompt appears, asking whether
you want to overwrite this file. Click Yes to All. You may have to wait for some
time while Symantec Packager extracts files from this archive.

Note: Click Extract Only to only extract the application and execute the
application later. You must run the axInstall.exe file to start the installation.

Select the Thin Client Install option from the installation types listed in the
Ghost Solution Suite Server Install Configuration dialog.

(Optional) Select the Include PXE Server option to install the PXE Server.
(See “PXE server” on page 27.) Click Install.

Click Yes on the Software License Agreement page.

Enter the following information on the Ghost Solution Suite Share Information
page:

= Inthe File Server path field, enter or browse to the path to install the Ghost
Solution Suite Server program files. The default path is c:\Program

Files\Altiris\eXpress\Ghost Solution Suite Server

= Select the Create Ghost Solution Suite Share option to create a Ghost
Solution Suite Share on the computer. The Ghost Solution Suite Share lets
you store files on the computer and run Ghost Solution Suite Server system
applications.
See “Ghost Solution Suite Share ” on page 26.

= You must enter an administrator user name and password for the Ghost
Solution Suite Server system. This account must already exist on the Ghost
Solution Suite Share and the Ghost Solution Suite Server. By default, the
name you are currently logged on as appears. If you use a domain account,
enter the domain and the user name (Example: Domain1\administrator).
See “Ghost Solution Suite Server” on page 23.
If a previous installation of the Ghost Solution Suite Database is detected,
an axinstall prompt appears, asking whether you want to preserve or
overwrite the existing database. Click Yes to preserve the data in your
Ghost Solution Suite Database.
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Click Next. The Pre-boot Operating System page appears.

9 Select a default pre-boot operating system from any one of the options, such
as Linux, WinPE, or None. Browse to locate the FIRM file (for Linux operating
systems) or enter the path for the operating system files (for WinPE). Click
Next. The Installation Information page appears, displaying the components
that you selected to install.

10 Click Install to install the listed components, or click Back to modify the settings
before starting the installation. The installation process begins and can take
several minutes. The Installation Information Summary page appears after
the installation completes.

Note: If you are upgrading your installation, the message Do you want to
replace the share? appears. Click Yes and continue. If you click No, a
message appears, stating that the share is already in use and you must
manually set the share to point to the correct directory. Click OK.

11 (Optional) You can select the following option to install agents.

= Remotely install Ghost Solution Suite agent (Windows Vista, Windows
2008 or later only). Select this option if you want to push the Ghost Solution
Suite agent to computers running Windows Vista, Windows 2008, and later
operating systems.

12 Click Finish.

You have successfully completed a Thin Client install for a Ghost Solution Suite
Server system. Click the Ghost Solution Suite Console icon on your desktop to
view all the computer resources running Ghost Solution Suite Agents configured
for your Ghost Solution Suite Server.

Note: Antivirus applications can delete service .EXE files or can disable services.

Example: When you run the Ghost Solution Suite Server Win32 Console, the "Unable
to connect to the Symantec Ghost Solution Suite Server Management Server.
Please ensure this service is started and running currently." error appears. This
occurs because the service files are deleted by the antivirus application during
scanning. To resolve this issue, disable the antivirus software and reinstall the
Ghost Solution Suite Server.
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Component install

The component install option lets you add selected Ghost Solution Suite Server
Components - Ghost Solution Suite Console, PXE Server, and Ghost Solution Suite
Agents to the existing Ghost Solution Suite Share . You can also add Microsoft
Sysprep files.

See “Ghost Solution Suite Server components” on page 22.

To run a component install

1 Start the server and log on using the administrator account you created for the
Ghost Solution Suite Server.

2 Launch the appropriate Symantec Ghost Solution Suite Server installation file
and follow the setup steps.
The Symantec Packager Self-Extracting Executable Options dialog appears.

3 Select the Use current temp folder option to use the current temporary folder
to download installation files or the Extract to a specific folder option to set
a path to an existing folder to download the installation files.

4 Click Extract and Execute App to extract and execute the application
immediately.

The default installation directory is c: \Dssetup. If the file
C:\DSSetup\AppLic.dll already exists, a prompt appears, asking whether
you want to overwrite this file. Click Yes to All. You may have to wait for some
time while Symantec Packager extracts files from this archive.

Note: (Optional) Click Extract Only to only extract the application and execute
the application later. You must run the axInstall.exe file to start the installation.

5 Select the Component Install option from the installation types listed in the
Ghost Solution Suite Server Install Configuration dialog and click Install.

Click Yes on the Software License Agreement page.
Enter a path for the Ghost Solution Suite Share and click Next.
Select the components you want to install and click Next.

» Install an additional Ghost Solution Suite Console. Select this option
to install another Ghost Solution Suite Console (a Windows executable) on
another computer. You can add as many Ghost Solution Suite Consoles
as required to manage from multiple consoles across your system, but you
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can install only one at a time. The Ghost Solution Suite Console
Information dialog appears.

= Install an additional Symantec PXE Server. Select this option to add
additional PXE Servers across a network segment to handle boot requests
for large environments. The PXE Server Information dialog appears.
Master PXE Server. When you add another PXE Server, the PXE Server
that you initially installed is designated as the Master PXE Server. The
Master PXE Server works concurrently with any additional PXE Server to
handle boot requests across the network segment, but it also allocates
additional blocks of IP addresses to other PXE Servers in the system.
For all the available options for installing PXE Server, refer to the following
section:
See “PXE server” on page 27.

= Install additional Ghost Solution Suite Agents. Select this option to
install additional Ghost Solution Suite Agents on client computers, setting
up managed computers in the Ghost Solution Suite Server system. The
Remote Agent Install dialog appears. Enter common administrator
credentials for all client computers.
See “Enter administrator account information” on page 43.

= Add Microsoft Sysprep files. Select this option to install the Microsoft
Sysprep files, if you did not install them earlier. The Sysprep dialog appears.
See “PXE server” on page 27.

Select the computer where you want to install the selected components and
click Next. The Installation Information page appears.

Note: If you select the On a remote computer option, you must browse and
select the remote computer.

Click Install to install the listed components or click Back to modify settings
before starting the installation. The installation process begins and can take
several minutes. The Installation Information Summary page appears,
specifying that the installation was successful.

Select the Install add-ons to provision server hardware option to install the
add-ons for Dell computers. Click Finish.

Note: This option is enabled on Dell computers only when add-ons are present
in the ceminstall-addons section of the oceminstall. ini file, which is located
in the eXpress directory. This is the only option available on the Installation
Information Summary page when you select Component Install.
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You have successfully completed a Component Install for a Ghost Solution Suite
Server system. Click the Ghost Solution Suite Console icon on your desktop to
view all the computer resources running Ghost Solution Suite Agents configured

for your Ghost Solution Suite Server.

Installing Ghost Solution Suite Agents

Each client computer requires the Ghost Solution Suite Agent to run as the
Production Agent on a local hard disk, which communicates with the Ghost Solution
Suite Server and registers in the Ghost Solution Suite Database. For Windows and
Linux client computers, Ghost Solution Suite lets you push agent software to a client
computer See “Installing the automation agent” on page 49. from a Ghost Solution
Suite Console, or you can pull the Ghost Solution Suite Agent to the client computer
from the Ghost Solution Suite Share .

You can install an embedded (recommended) or hidden automation partition, which
contains an Automation Agent that establishes communications with the Ghost
Solution Suite Server to run the deployment jobs that are assigned to the client
computer.

= Ghost Solution Suite agent. Install a Production Agent to a Windows desktop,
notebook, or server computer. You can also install this agent on any supported
Linux workstation or server.
See “Installing Ghost Solution Suite agent for Windows” on page 45.

= Ghost Solution Suite agent on Linux. Install on any supported Linux
workstation or server.

See “Installing Ghost Solution Suite agent on Linux” on page 47.

= Automation Agent. Install on any Windows desktop, notebook, or server
computer.

= Ghost Solution Suite agent on XP, 2003, Vista (Business) and 2008 Server.
Install the Ghost Solution Suite agent on the selected Windows XP, Server 2003,
Vista (Business), and Server 2008 computers.

Client connectivity and network adapters

Symantec supports all standard network adapter cards and includes many drivers
with the installation of Ghost Solution Suite . However, sometimes outdated drivers
(including default drivers that come with the hardware) cause problems when clients
are in automation mode. To avoid these problems, you should check the
manufacturer's Web site for your network adapter to ensure you use their latest
driver in your pre-boot operating system configuration file.
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Some common client problems that can be solved by updating drivers are:
= Locking when loading drivers or failing to connect to the server

» Locking when imaging (downloading, uploading, or multicasting)

Microsoft client drivers

The Boot Disk Creator is set up to work with drivers that follow a certain standard.
Because not all NIC drivers follow that standard, you may have to move the files
to a different location.

Ensure that the following files are in the same directory:

» The sample protocol.ini that comes with your driver (protocol.ini)
= The OEM setup file that specifies the DOS driver (cemsetup.inf)
Example: The OEM setup file may contain lines similar to the following:
[netcard]

NGRPCI="NETGEAR FA310TX Fast Ethernet PCI
Adapter",0,ndis,ethernet, real, NGRPCI,NGRPCI NIF

[NGRPCI] (This header must be the sixth item listed in the line above)

Device=NGRPCI.DOS (If this line is missing, add it. The syntax is

device=drivername.)

If there is no protocol.ini file, create a text file that contains the following

command: DriverName=drivername.

Novell client drivers
The Boot Disk Creator performs the following functions:

» Searches all subdirectories for a directory that contains *.ins, *.com, and net.cfg
files. (These files must be in the same directory.) The .INS file is opened to get
information about the network card.

= Searches the file for a line starting with a carat (*). This line must have at least
two values listed, separated by a comma. The two values needed are the
description of the card (value1) and the .com driver file name (value2).

Installing the Ghost Solution Suite agent

For client computers running a Windows operating system, Ghost Solution Suite
lets you install agent software using the Remote Agent Installer to "push” the agent
to a client computer from a Ghost Solution Suite Console. (See “Remote agent
installer” on page 42.) You can also pull the Ghost Solution Suite agent to the client
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computer by accessing the Windows share. You must have administrative rights
to the client computers and File and Print Sharing must be enabled to install the
agent software.

Click Remote Agent Installer on the Ghost

"'I'::; | Solution Suite Console toolbar, or click Tool

> Remote Agent Installer to open the utility

program. You can also download aclient.exe
from the network share to install a Ghost
Solution Suite agent.

Remote agent installer

DAgent replaced AClient as the default agent for the following Windows platforms:

Windows 2000 SP4 or higher
Windows 2003 Server
Windows XP SP2 or higher
Windows Vista

Windows 2008 Server
Windows 2008 Server R2
Windows 7

Windows 8

Wndows 8.1

Windows Server 2012
Windows Server 2012 R2

Windows XP

To install, each XP computer must have the following items:

An Administrator account with a password. This account must be able to browse
\\hostname\admin$ on the selected computer.

Disabled simple file sharing. This option can be disabled in Windows Explorer
by selecting Tools > Folder Options > View tab and clearing the Use simple
file sharing check box in the Advanced settings section.

Enabled File and printer sharing in the Windows Firewall.
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Windows 2003, Vista, 2008 servers, and Windows 7

You must enable file and print sharing in the Windows Firewall.

Enter administrator account information

Enter common administrator credentials for all client computers, or keep the default
credentials to be prompted for each client computer.

Let me specify a username and password for each machine as it's installed.
Prompts for an administrative user name password for each computer in the remote
install list. This is the default option.

Use this username and password for all clients. Enter credentials for an
administrator account that has rights to all the client computers that you add to the
remote install list.

Specify install directory

Enter a location to install the Ghost Solution Suite agent.

Install directory. Enter the path to install the Ghost Solution Suite agent on the
client computer.

Enable this agent to use SIDgen and/or Microsoft Sysprep. If you plan to use
SIDgen or Sysprep to configure this computer the required files can be copied when
the agent is installed.

Click Change Settings to set the Ghost Solution Suite agent settings.

Automatically add to a group

You can select one of the following options to automatically add new computers to
the group that you specify.

Add client(s) to default group. Adds new computers to the All Computers group.

Add client(s) to a specific group. Adds new computers to another group. Use
back slashes to separate subgroups.

Select computers on the network

Identify client computers on the network and add them to a list of computers to
remotely install the Ghost Solution Suite agent.
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Add. Select the computers by the name in the list, or enter a computer name or IP
address.

Computer Name. Enter the name of a computer on the network or its IP address.

Properties. Select a computer and view the agent install settings. You can also
change SID and Agent settings from the Agent Properties dialog.

Import. Import new computers from a file. This file has the following parameters:
-c: [computer] -u:[username] -p:[password] -i:[input file]. The
parameters must be entered in this order. The password parameter is not required
if the administrator account does not have one assigned. If you are using the default
settings, you do not need to specify an input filename. Each computer entry must
be on a separate line.

Export. You can export the listed computers into an export file to use later. The
default extension is *.RCIl. Remote Agent Installer first looks for an RCI file extension.

When the computers appear in the installer list and the properties are set, click
Finish. The status of the agent install appears.

After the Ghost Solution Suite agent is installed, it automatically connects to the
Ghost Solution Suite Server and appears in the Computers pane of the Ghost
Solution Suite Console.

Download Microsoft sysprep

If you select Enable this agent to use SIDgen and/or Microsoft Sysprep on the
previous dialog, the Remote Agent Installer dialog locates the required installation
files for the specific versions of Sysprep.

Update file system permissions when changing SIDs. Select this option to
automatically update file system permissions to maintain the individual file
permissions that you may have set. This also includes the individual network shares
that may exist on this client. On selecting this option, SID conversion takes a long
time.

Note: SIDgen is no longer supported and should not be used. Symantec
recommends using Microsoft Sysprep in situations where SID replacement is
required.
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To install Microsoft Sysprep, you must

o download the installation files required for the
g Windows operating systems running on the
client computer.

Windows 2000/XP/2003 (deploy.cab)

We recommend installing these files from a
Windows 2003 server CD. Windows Vista
and 2008 Server include sysprep files by
default.

Change settings

Click Change Settings to modify access, security and other settings on the Ghost
Solution Suite agent to be installed.

Get server security key

This page appears only if you select the Enable key-based authentication to
Ghost Solution Suite Server option in the Default Agent Settings dialog.

Enter the security key file path for the Ghost Solution Suite Server or browse and
select a file containing the security key file path.

Installing Ghost Solution Suite agent for Windows

Run dagent.msi from the Ghost Solution Suite Share (shared folder).

1. On the Symantec Client Service dialog, enter a location to install the Ghost
Solution Suite agent. Select one of these options, if required, and click Next:

= Secure modification of server properties. Select to prohibit users from
changing any agent settings.

= Enable changing of Security ID. Select to manage the security IDs to run
a SID utility as part of an imaging job.

» Advanced. Click to open the Computer Configuration Properties dialog
and enter the settings for the Ghost Solution Suite agent you are installing.

2. If you have enabled the security IDs, a page listing the options for managing
the SIDs appears. Select the utilities you want to use and enter the path where
the utilities are stored. Click Next to install the Ghost Solution Suite agent.
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3. (Optional) Select a group in the Ghost Solution Suite Console to add the client
to. You can also leave it at the default group.

After the Ghost Solution Suite agent is installed, it connects to the Ghost Solution
Suite Server and appears in the Computers pane of the Ghost Solution Suite
Console.

See “Installing Ghost Solution Suite Agents” on page 40.

Automating the installation of Ghost Solution Suite
agent

If you do not select Remote Agent Installer to install the Ghost Solution Suite agent,
install the Ghost Solution Suite agent using log-on scripts or batch flies. However,
this requires that you manually complete the installation at each client computer.
Instead, you can use a template file to set applicable options and properties.

The template file is a text file that can be used to automate configuration of the
properties when installing the Ghost Solution Suite agent from a batch file, login
script, or manually from a client computer.

The template file can be created using two methods: editing the sample. inp file or
using Remote Agent Installer.

Editing the sample.inp file

Ghost Solution Suite ships with a sample template file named sample.inp, which
contains the commands to configure installation options and properties. This file is
located in Program Files\Altiris\eXpress\Ghost Solution Suite Server.

Most of the parameters are disabled in this file. To enable an option, remove the
semicolon. Example: To specify an IP address and port number for the client to
locate the Ghost Solution Suite Server, remove the semicolon from the Tcpaddr
and Tcpport lines and change the address and port number to the correct values.

Using remote agent installer

You can create a template file when running Remote Agent Installer. After modifying
agent properties and adding computers to the Selecting Clients window, click
Export to create a template file to import computers (*.rci) as well as the template
file (*.inp).
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Example: If you have computers named PC-1 and PC-2 listed in the Selecting
Clients window and you export these computers using the file name Export.rci,
the following two template files are created:

Export PC-1.inp

Export PC-2.inp

Using the template file

To use the template file you create, run the aclient.exe installation program
specifying the template file and using the -install switch.

Example:
\\FX1\eXpress\AClient.exe aclient.inp -install

The following command-line options are available:

Option Definition

-install AClient.exe runs and installs the Ghost
Solution Suite agent on the computer instead
of just running it in memory.

-remove Permanently removes the Ghost Solution
Suite agent from the computer where it is
installed.

-silent Lets you use the options without being

prompted for further input.

-stop Stops the Ghost Solution Suite agent from
running, but does not remove it. The next time
the computer is booted, the Ghost Solution
Suite agent runs in production mode.

-start Starts the Ghost Solution Suite agent. This
option works only when Ghost Solution Suite
agent is installed on the computer.

Installing Ghost Solution Suite agent on Linux

You can install the Ghost Solution Suite agent on any supported Linux workstation
or server by downloading and running the Ghost Solution Suite agent for Linux

installation file (a .BIN file) on the client computer. The Ghost Solution Suite agent
is updated automatically on Linux computers when you upgrade to a new version
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of Ghost Solution Suite . The creation date of the Ghost Solution Suite agent is
checked and updated when a new agent is available.

Installing the Ghost Solution Suite agent for Linux

1

After downloading the .B1N file to a local directory, you can install from the
command line.

= Browse to the directory where you saved the .B1N file, switch to the root
user (su) and change the directory to the location of the . B1n file by entering

(cd < directory>)

= After changing the directory, you must have the permission to execute the
.BIN file; to obtain the permission, enter chmod 544 <filename>

s Enter: ./<file name>

The Ghost Solution Suite agent for Linux is installed in the
/opt/altiris/deployment/adlagent directory.

To change the adlagent configuration file settings, update the ad1agent.conf
file. This file is located in the /opt/altiris/deployment/adlagent/conf
directory. You can also change the adlagent configuration file settings by
executing the configure script from the
/opt/altiris/deployment/adlagent/bin directory.

= To edit the configure file directly, open the adlagent .conf file located in
the/opt/altiris/deployment/adlagent/conf directory and make the
required changes.
You can also edit the configuration file to change the functionality or
properties. Example: You can open the adlagent.conf file in an editor and
scroll to the [Transport] section and the UseMcast line. Change
UseMcast=true {0 UseMcast=false. In the TCPAddr=<IP address> line,
enter the IP address of the specific Ghost Solution Suite Server you want
to manage the client computer. You can also identify and edit additional
configuration settings in the configuration file.

= To run the script to change the settings for the adlagent configuration file,
browse to the /opt/altiris/deployment/adlagent/bin directory from
the shell and enter . /configure
You are prompted to select Multicast options to identify a Ghost Solution
Suite Server to manage the current client computer, or you can select a
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specific Ghost Solution Suite Server by setting the Multicast option to false
and adding the IP address of the required Ghost Solution Suite Server.

3 After editing the configuration file, restart the Ghost Solution Suite agent for
Linux.

To start and stop the Ghost Solution Suite agent for Linux, enter the full path
or browse to the /etc/rc.d/init.d directory (with administrator/root rights).
You can use either the adlagent stop and adlagent start commands, or
only the adlagent restart command. You can also use the Package Manager
installed with Linux to restart the Ghost Solution Suite agent for Linux.

By stopping and starting the Ghost Solution Suite agent for Linux, the service
updates the changes made in the adlagent configuration file.

You can now view the Linux managed computer from a Ghost Solution Suite
Console.

See “Installing Ghost Solution Suite Agents” on page 40.

Installing the automation agent

After Ghost Solution Suite Server has detected a managed computer through the
Ghost Solution Suite agent in a production environment, you can install an
Automation Partition from the Computers pane.

Here are some other ways to create and install an Automation Agent, which is saved
in an embedded (recommended) or hidden partition on the client computer's hard
disk.

» For Ghost Solution Suite systems running the PXE Server, create boot menu
options from the PXE Configuration Ultility, using one of the following methods:
Boot Disk Creator, Direct from floppy, or User Specified. See PXE
Configuration Utility Help.

= To install an Automation Partition you can create a Microsoft Install Package
(MSI) and deploy it using a job from the console. You can also create floppy
disks, bootable CDs with an ISO image, or bootable USB devices. See Boot
Disk Creator Help.

To install an automation partition

Installation help

The following are the help file topics for the Ghost Solution Suite Server installation
program that you can access by clicking Help or pressing the F1 key. These topics
identify and explain the elements on the dialogs used in the installation process.
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Configuration

The Ghost Solution Suite Server system supports a Simple Install as well as a
Custom Install option. A Simple installation lets you install all components on a
single computer. The Custom installation lets you distribute individual components
of a Ghost Solution Suite Server system on multiple computers. The Thin Client
Install lets you install the Thin Client view of the Ghost Solution Suite Console on
your computer. The Component Install option lets you install additional components
on your system.

Installation type

Simple install. Select this option to install all Ghost Solution Suite Server
components on a single computer. This configuration is recommended for managing
computers on a single LAN or across a site with few subnets.

See “Simple install for Ghost Solution Suite Server” on page 28.

Include PXE server. Select this option to install the PXE Server when running the
Simple install option. The PXE Server requires a DHCP server also installed on
your network.

See “PXE server” on page 27.

Custom install. Select this option to install Ghost Solution Suite Server components
on multiple computers across your system. A Custom Install lets you balance
network activity for large enterprises with multiple subnets. Example: Use this option
to distribute the Ghost Solution Suite Database on another computer or assign
another file server as the Ghost Solution Suite Share to store image and package
files.

See “Custom install for Ghost Solution Suite Server” on page 31.

Thin client install. Select this option to install the Thin Client view of the Ghost
Solution Suite Console on your computer. You do not require a license file to install
this view.

See “Thin client install” on page 35.

Component install. Select this option to install additional Ghost Solution Suite
Server components on your system. Example: Use this option if you want to add a
PXE Server to your Simple or Custom installation, or if you need multiple Ghost
Solution Suite Consoles.

See “Component install” on page 38.

If you have multiple network adapter cards, a secondary dialog appears asking you
to select the IP address for the Ghost Solution Suite Server interface.
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Note: If you run the Ghost Solution Suite Server on a MS Windows Server 2003
Domain Controller with SMB Signing enabled, you cannot execute any imaging
jobs. When running jobs on MS Windows Server 2003, you must change the SMB
Signing Registry Key to execute deployment jobs.

To disable SMB signing on the Windows 2003 server

1 Click Start > Control Panel > Administrative Tools > Local Security Policy
> Local Policies >Security Options.

2 Locate the Microsoft network server: Digitally sign communications
(always) policy setting, right-click it, and select Properties > Disabled.

3 Disable the Microsoft network server: Digitally sign communications (if
client agrees) policy setting as well. This is enabled by default.

Installing Ghost Solution Suite Server

Specify the Ghost Solution Suite Share (shared directory) where you want to store
the image files, .RIPs, and other package files. Before installing the Ghost Solution
Suite Server, ensure that you have a shared Windows or NetWare directory with
free disk space and appropriate security rights.

File server path. Select the drive letter and directory path where you want to install
the Ghost Solution Suite Server. The default path is the Program Files directory on
the local computer.

Create Ghost Solution Suite Share . If you are installing the Ghost Solution Suite
Server on a local Windows computer, select this option to create a shared directory
as your Ghost Solution Suite Share . If you are installing on a remote file server or
if you select an invalid path, this option is unavailable.

Note: If you are installing the Ghost Solution Suite Server on a remote file server,
create a share or grant access rights to the Ghost Solution Suite Server directory
on the file server before you start the installation. For Windows XP, you must run

the Network Setup Wizard accessed from My Network Places to enable sharing.

See “Ghost Solution Suite Share ” on page 26.
Select one of the following options to configure the licensing information:
See “Ghost Solution Suite Server components” on page 22.

See “Installing Ghost Solution Suite Server” on page 51.
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Installing Ghost Solution Suite Server using component install

Specify the Ghost Solution Suite Share (shared directory) where the image files,
RIPs, and other package files are stored. Ensure that you have a shared Windows
or NetWare directory with available disk space and security rights before installing.

See “Ghost Solution Suite Share ” on page 26.

Ghost Solution Suite Server install

Install the Ghost Solution Suite Server on a computer. The service is identified in
the Services section of the Windows Computer Management as Altiris eXpress
Server.

See “Ghost Solution Suite Server” on page 23.

To install service on a local computer

1 Select the On this computer option.

2 Enter the Ghost Solution Suite Server IP address and port information.
3 Enter the path to install the Ghost Solution Suite Server.
4

Enter the user name and password of the Ghost Solution Suite Server. For a
domain account, enter the domain and user name. Create this account before
starting the installation.

To install service on a remote computer
1 Select the On a remote computer option.

2 Enter the name of the computer or browse to where you want to install. By
default, the destination path and IP address of the computer appear.

3 Enter the user name and password of an administrator account for the Ghost
Solution Suite Server computer. For domain accounts, include the domain
name (Example: orgDomain\admin). The user account must have rights to the
Ghost Solution Suite Share . Create the administrator domain account before
starting the installation.

See “Ghost Solution Suite Share ” on page 26.
See “Ghost Solution Suite Server components” on page 22.

See “Installing Ghost Solution Suite Server” on page 51.

Pre-boot operating system (simple)

Select a pre-boot operating system, which the Ghost Solution Suite Server can use
as the default, when creating a deployment job with an automation task. You can
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also install additional pre-boot operating system files later by using Boot Disk
Creator.

If you are running a PXE Server in your system environment, the first pre-boot
operating system that you install becomes the default boot menu option for Initial
Deployment. The menu options display Linux Managed, or Windows Managed.

You can assign an automation pre-boot operating system to an automation task
when it is added to a deployment job. This flexibility lets you run several automation
tasks within a single job, and each task can boot to the automation environment
you want.

= None. Select this option if you do not want to provide a default automation
operating system. You can also select this later through the Boot Disk Creator
utility.

= Linux. Browse to the BDCgpl.frm file that is present in the GPL folder.
=  WIinPE. Browse to the WinPE files.
n See Boot Disk Creator Help and PXE Configuration Help.

Pre-boot operating system (custom)

Select a pre-boot operating system that the Ghost Solution Suite Server can use
as the default when creating a deployment job with an automation task. You can
also install additional pre-boot operating system files later by using Boot Disk
Creator.

If you are running a PXE Server in your system environment, the first pre-boot
operating system that you install becomes the default boot menu option for Initial
Deployment.

You can assign an automation pre-boot operating system to an automation task
when it is added to a deployment job. This flexibility lets you run several automation
tasks within a single job, and each task can boot to the automation environment
you want.

= Linux. Browse to the BDCgpl . frm file that is present in the GPL folder.
=  WIinPE. Browse to the WinPE files.
See Boot Disk Creator Help and PXE Configuration Help.
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Ghost Solution Suite Database install

Install the Ghost Solution Suite Database on a local or remote server with or without
an existing Microsoft Data Engine (MSDE) or Microsoft SQL Server. To install the
database, you must have administration rights to the selected server.

See “Ghost Solution Suite Database” on page 25.

Note: If you have multiple instances of the Microsoft SQL Server already set up,
you can identify a specific instance using this format: <soL server
Name>\<database instance>. The instance of the database can vary. Example:
If you have a clustered Microsoft SQL Server to manage multiple Ghost Solution
Suite systems on different network segments, you can enter the name
salesSegment\express Of marketingSegment\express depending on the previously
established database instance.

Install the Ghost Solution Suite Database using these options:

= Select the Microsoft SQL Server instance where you want to install your Ghost
Solution Suite Database.

= You can also change the default SQL Port number.

= You can rename the Ghost Solution Suite Database default name, eXpress, by
entering a different name in the Database Name field. However, this does not
alter the Ghost Solution Suite Share name.

See “Ghost Solution Suite Server components” on page 22.

PXE server install

Select the options to boot locally using the Symantec Automation Partition. For
PXE-compliant computers, you can boot across the network using the Intel Pre-boot
eXecution Environment option in the PXE Server.

See “PXE server” on page 27.

Note: If you have a Novell NetWare file server, you must set up the PXE Server
after installing the Ghost Solution Suite Server. The Universal Network Device
Interface (UNDI) default driver is not supported by Novell NetWare.

= Select the No | will be using an Symantec automation partition on each
client computer option, if you do not want to use PXE and prefer to use
embedded (preferred) or hidden partitions, or bootable media to run tasks.
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Note: This option is unavailable for installing the PXE Servers using the
Component Install option.

= Select the Yes, | want to install PXE Server on this computer option to install
the PXE Server on the local computer.

Note: This option is selected by default for the Component Install.

= Select Yes, | want to install PXE Server on a remote computer to install the
PXE Server on a remote computer. Enter the name of the computer and the
path.

= Enter the IP address for the PXE Server and the Ghost Solution Suite Server.
= Enter the path where you want to install the PXE Server.

= Select the pre-boot operating system that can be used as the default PXE boot
menu item. The pre-boot operating system options that are enabled depend on
the options you selected for the pre-boot operating systems in the Pre-boot
Operating Systems page. Example: If you select Linux in the Pre-boot
Operating Systems page, the Linux option is enabled as the default PXE boot
menu item. For more information, PXE Configuration Utility Help.

See “Installing the automation agent” on page 49.

See “Pre-boot operating system (simple)” on page 52.

Client connection to server

Select the protocol your managed computers can use to connect to the Ghost
Solution Suite Server.

Connect directly to Ghost Solution Suite Server. Installs the PXE Server using
the Intel Pre-boot eXecution Environment (for PXE-compliant computers only). You
can use this without PXE for faster access, as it goes directly to the IP address
without searching.

If managed computers are on a different segment or if you are using the PXE Server
with an UNDI driver, click Connect directly to Ghost Solution Suite Server and
enter the IP address of the Ghost Solution Suite Server that the managed computers
can connect to. Do not change the port number unless the default is already being
used.

Note: If you change the port number, you must change the client configurations.




Sysprep

Installing Ghost Solution Suite Server
Sysprep

Discover Ghost Solution Suite Server using TCP/IP multicast. Lets the managed
computers connect to any Ghost Solution Suite Server. To use multicasting and
connect to a specific Ghost Solution Suite Server, enter the name of the Ghost
Solution Suite Server computer.

Multicasting cannot be used with the UNDI driver. If you want to use different drivers
on the PXE Server, you can create multiple PXE boot files after installing.

Enter the location of the Microsoft Sysprep files according to the operating system.
Specify the location or browse and select the required files.

Installing components

Click Install, or click Back to change the settings.

See “Ghost Solution Suite Server components” on page 22.

Installation information summary

The components are installed.
You can remotely install Ghost Solution Suite Agents..

Remotely install Ghost Solution Suite agent (Windows Vista, 2000 or later
only). Select this option to push the Ghost Solution Suite agent.

Click Finish.

See “Ghost Solution Suite Server components” on page 22.

Add components summary

The components in the list are installed.

Download Adobe Acrobat. Select this option to download the Adobe Acrobat
Reader to read the documentation in the .PDF format.

Click Finish.

See “Ghost Solution Suite Server components” on page 22.
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Ghost Solution Suite Database authentication

Specify the type of authentication the Ghost Solution Suite Database will use. You
can select Windows authentication or SQL Server authentication. If you select SQL
authentication, enter the user credentials with administrative rights for the SQL
database.

Use Windows NT authentication. Select this option to use the Windows network
or Active Directory authentication.

Use SQL Server authentication. Enter the user name and password set for the
Microsoft SQL Server. If using MSDE, the default "sa" user name is used and no
password is required.

See “Ghost Solution Suite Server components” on page 22.

See “Installing Ghost Solution Suite Server” on page 15.

Add components

If you have already installed Ghost Solution Suite Server, you can add components
to the existing system. Select the type of component you want to add.

See “Ghost Solution Suite Server components” on page 22.



Upgrading to Ghost
Solution Suite 3.0

This chapter includes the following topics:
= Supported upgrade paths for Ghost Solution Suite 3.0

= Upgrading from Deployment Solution 6.9 SP6

Supported upgrade paths for Ghost Solution Suite
3.0

The supported upgrade paths of the Ghost Solution Suite 3.0 from the earlier release
versions to the latest release version are as follows:

Table 3-1 Upgrade and Migration paths for Ghost Solution Suite 3.0
Upgrade or migrate from To Ghost Solution Suite 3.0
Deployment Solution 6.9 SP6 As Ghost Solution Suite 3.0 has evolved primarily from Deployment Solution

6.9, it works seamlessly with the Deployment Solution 6.9 database. There
are no changes in the log location and the path of where the images are stored.

Symantec recommends to use the existing database while migrating from
Deployment Solution 6.9 SP6.

Note: Ghost Solution Suite 3.0 supports the WIinPE 5.1 version. If you have

already installed the ADK for WIinPE 4.0 that is consumed in the Deployment
Solution 6.9, then after installing Ghost Solution Suite 3.0, the manage WinPE
for 5.1 is created and overwrites the existing manage WinPE image of 4.0.
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Table 3-1 Upgrade and Migration paths for Ghost Solution Suite 3.0
(continued)
Upgrade or migrate from To Ghost Solution Suite 3.0
Ghost Solution Suite 2.5.1 There is no supported upgrade path from Ghost Solution Suite 2.5.1.

To upgrade from Ghost Solution Suite 2.5.1 to Ghost Solution Suite 3.0, you
must install the Ghost Solution Suite 3.0 as a fresh installation.

You can reuse the images that you have captured using Ghost Solution Suite
2.5.1. You must manually copy the images to the following path in the Ghost
Solution Suite Sever:

<Install Dir>:\Program Files
(x86) \Altiris\eXpress\Deployment Server\Images\

You cannot reuse the database from Ghost Solution Suite 2.5.1.

Upgrading from Deployment Solution 6.9 SP6

As Ghost Solution Suite 3.0 has evolved primarily from Deployment Solution 6.9,
it works seamlessly with the Deployment Solution 6.9 database. There are no
changes in the log location and the path of where the images are stored. Symantec
recommends using the existing database while migrating from Deployment Solution
6.9 SP6.

Note: Ghost Solution Suite 3.0 supports the WinPE 5.x version. If you have already
installed the ADK for WinPE 4.0 that is consumed in the Deployment Solution 6.9,
then after installing the Ghost Solution Suite 3.0, the WinPE image for 5.x is created
and overwrites the existing manage WinPE image of 4.0.

The following table lists the steps that you must follow to upgrade to Ghost Solution
Suite 3.0
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Table 3-2 Process to upgrade to Symantec Ghost Solution Suite 3.0

Step Action Description

Step 1 Upgrade the Deployment Server to Ghost | Upgrade the existing Deployment Server to Ghost
Solution Suite Server Solution Suite Server.

To upgrade to Ghost Solution Suite Server, run the
Ghost Solution Suite 3.0.exe onthe
computer on which the Deployment Solution 6.9
SP6 is already installed.

Provide a valid SLIC license or you can use a
14-days trial license by clicking on Next.

Note: The existing Deployment Solution 6.9 LIC
license does not work with Ghost Solution Suite

3.0.
See “Installing Ghost Solution Suite Server”
on page 15.
Step 2 Restore the database and set up for Retain the Express Share file server path and
creating preboot images provide the existing Deployment Solution 6.9 SP6

database name.

Provide the latest FRM file and the ADK 8.1 setup
file to create the LinPE and WinPE 5.0 preboot
images.

Select default options for other settings and start
the installation by clicking on Install.

Step 3 Upgrade the client computers with Ghost | After the installation of Ghost Solution Suite
Solution Suite 3.0 agent completes, launch the Ghost Solution Suite
console.

The existing clients that are connected to the Ghost
Solution Suite server automatically start upgrading
with the latest version of the Ghost Solution Suite
agent.

See “Installing Ghost Solution Suite Agents”
on page 40.




Troubleshooting tips

This appendix includes the following topics:

= Troubleshooting tips

Troubleshooting tips

The following table lists the troubleshooting tips of Ghost Solution Suite 3.0:

Table A-1 Troubleshooting tips
Issue Description Workaround
The SEP Network Threat The SEP Network Threat Disable the following:
Protection feature blocks PXE | Protection feature blocks PXE

= Network-related policies
= Turn off the firewall if you want to install the
agent remotely using RAI.

server connection. server from connecting to Ghost
Solution Suite client computers.
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